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To Use the Front Panel

You can use the dedicated front-panel knobs and buttons to do the most commonly performed operations.

Turn INTENSITY to adjust waveform intensity.

Push FastAcq to turn Fast Acquisition on and
off. Fast Acquisition mode is powered by
DPX™ technology.

Push CURSORS to turn cursors on and off.

Push PRINT to make a hard copy.

Push DEFAULT SETUP to return settings to the

default values.

Push AUTOSET to quickly set the vertical,

horizontal, and trigger controls for a
usable display.

Use the multipurpose knobs to control —< |

parameters selected from the screen interface.
Push a FINE button to make small changes with
a multipurpose knob.

Push to turn the touch screen on and off.

Push MulitView Zoom™ to add a magnified

INTENSITY

graticule to the display. Push the HORIZ or VERT
button to select the axis that you want to
magnify.

Use these knobs and buttons to set horizontal
SCALE and POSITION for the waveforms. Push
DELAY to turn on horizontal delay, and then
use POSITION to set the delay time. Adjust
RESOLUTION to change the number of
acquired points in the waveform.

Use these knobs and buttons to set the basic
trigger parameters. Push ADVANCED to display
a menu of additional trigger functions.

Use these buttons to start and stop

acquisition or start a single acquisition ~
sequence. The ARM, READY, and TRIG'D
lights show the acquisition status.
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Turn channel displays on and off, and adjust the —»<
channel POSITION and SCALE using dedicated
knobs and buttons.
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To Use the Screen Interface

You can control all oscilloscope functions except the power switch using only the screen interface.

Touch here to
r change to menu
bar operation.

Choose the Toolbar
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Touch a button in the toolbar to display a —|
control window at the bottom of the display.
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knob to adjust the parameter value.

Touch here to change to
toolbar operation.

Choose the Menu Bar
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Touch here to close a
control window.

More Operating Tips:

m Use the touch screen to control the oscilloscope when bench space is
unavailable, such as on a cart or in an equipment rack.

®  Plug in a mouse and keyboard if you have the bench space to use them. You can
plug in a USB mouse or keyboard anytime, even while the oscilloscope is
running.

m  Use the menu bar to access PC-related functions, such as Page Setup, Export,
and Copy.



To Display a Waveform

Attach a probe to CH 1 and connect the probe {

to your signal.
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Adjust RESOLUTION to change the record § 6

length and sample rate. You can acquire
more samples in the waveform to see more
detail or acquire fewer samples with a
faster update rate.

Adjust INTENSITY to change the
brightness, vector fill, and display
persistence of acquired points.



To See More Waveform Detail

Use MultiView Zoom

Push the Multiview ZOOM™ button to display a
zoom graticule, display zoom on zoom, and
create up to 4 zoomed views of a waveform.

Push the HORIZ button or the VERT button
to select the axis to magnify in the zoom
graticule. Use the multipurpose knobs to

adjust the position and magnification
factor of the zoomed waveform.

You can also set up a MultiView Zoom

graticule from the screen interface. First
touch and drag across the segment of the
waveform that you want to see in greater
detail.

Then select a MultiView Zoom mode from the
drop-down list to magnify the highlighted
waveform segment.

Use Horizontal Delay

Push the front-panel DELAY button.

Adjust the delay time with the horizontal

POSITION control, or enter the delay time
in the control window.

Adjust the horizontal SCALE to acquire

the detail you need around the delay
expansion point.

More Operating Tips:

Use the MultiView Zoom function to magnify an acquisition vertically, horizontally, or
in both waveform dimensions. POSITION or FACTOR changes that you make to the
MultiView Zoom graticule affect only the zoom display, not the actual acquired
waveform. You can select and lock together waveforms, and then scroll them
automatically.
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Use horizontal DELAY to acquire waveform detail in a region that is separated from
the trigger location by a significant interval of time.

Tri :
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Zoom™
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= You can use MultiView Zoom and Horizontal Delay together to magnify a delayed
acquisition.

m  Toggle Horizontal Delay on and off to quickly compare signal details at two
different areas of interest, one near the trigger location and the other centered at
the delay time.



To Use Fast Acquisition

Turn Fast Acquisition on to acquire up to 400,000 waveforms per second. Fast Acquisition is powered by DPX™ technology

Push the front-panel FastAeq (purple) button. {1 —

Or select Fast Acquisitions in the Horiz/Acq
menu.

Adjust INTENSITY to optimize the intensity or 2
color grading for the signal being analyzed.
Increasing intensity can make less-frequently
acquired points brighter in the display.

How DPOs Work

Digital Phosphor Oscilloscopes (DPOs),
powered by DPX™ technology,
continuously acquire waveforms at rates
comparable to analog oscilloscopes. In
Fast Acquisition mode, DPOs
continuously overlay the acquired
information into a three-dimensional
database that is updated on the display
30 times per second. For each pixel in
the display, the intensity (or color) of the
pixel is proportional to the number of
actual samples that the pixel represents.
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More Operating Tips:

m  Choose one of the color grading palettes in the Display Colors control window to
see different sample densities represented in different colors.

®  Turn AutoBright on in the Display Appearance control window. When you use
AutoBright, the displayed waveforms remain visible even at low trigger repetition

rates.



To Choose an Acquisition Mode

Select Horizontal/Acquisition Setup...in | —

the Horiz/Acq menu or touch the Horiz
button; then open the Acquisition tab.

Select an acquisition mode in the
horizontal/acquisition control window.

For Average or Envelope acquisition modes,
touch the # of Wfms control and then set the
number of waveforms with the multipurpose
knob. You can also double-touch the control

and use the pop-up keypad.

How the Acquisition
Modes Work

Sample mode retains one sampled point from
each acquisition interval.

Waveform Data Base mode takes an ensemble
of acquisitions that is best for accurate eye
pattern measurements.

Peak Detect mode uses the highest and
lowest of all the samples contained in two
consecutive acquisition intervals.

Hi Res mode calculates the average of all
the samples for each acquisition interval.

Envelope mode finds highest and lowest record
points over many acquisitions. Envelope uses
Peak Detect for each individual acquisition.

Average mode calculates the average value for
each record point over many acquisitions.
Average uses Sample mode for each individual
acquisition.
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To Select a Trigger

IC——TRIGGER—D™

ETT) Display Cursors Measure Ma

Es D AEvent (Main) Trigger Setup...
e 5 Even ey TrgerSeu..
SOURCE COUPLING  SLOPE gﬂ ::232;:333 :
Eage Setup.
i Bimi e
Select the EDGE trigger type and then set the —— - e
source, coupling, slope, and mode with these Tianaton Stp.
front-panel controls. Push ADVANCED to select - F
one of the other trigger types. @ @& PUSH TOSET &% e
] ] Sl = O @ e
You can also select a trigger type in the Trig Runiop .
menu.
Or touch the Trig button, a Trigger Type button —— i [
and then select a trigger type in the window o — RS R W
that is displayed. Most triggers can be logic weor [ /
qualified. - B
Transition Set 50% Slope
Trigger Selections
Trigger type Levels Timers Trigger conditions
Edge Single level None Trigger on the rising, falling, or either edge, as defined by
/; slope control. Coupling choices are DC, AC, AC LF Reject,
_ AC HF Reject, and Noise Reject.
Comm <X Depends on Coding None Trigger on comm signals. Optional on TDS7000B series.
] Trigger on 64-bit serial pattern data.
Serial TLIL Single level plus clock None Optional on TDS7000B series.
ooio and bit pattern

Glitch Single level One to specify glitch Trigger on glitches narrower than the specified width or
j_\l—.ni width ignore glitches narrower than the specified width.

Width e Single level Two to specify minimum Trigger on pulses that have widths between the range of
4 \ and maximum pulse the two timers or outside the range of the two timers.

. widths
i One to specify an . - .

Runt Two levels to define the optional minimum Trigger on a pulse that enters the transition region from

logic transition region runt-pulse duration one side but does not leave the region from the other side.

Timeout Single level One to specify time-out Trigger when a signal does not make a transition for a

k time specified length of time.

Transition — Two levels to define the One to specify transition Trigger when a logic signal spends more time or less time
N logic transition region time in the transition region than a specified amount of time.
=

Setup/Hold ———— Independent levels for One to specify setup Trigger on violations of setup or hold time between a Data

Data and Clock

time and one to specify
hold time

signal and a Clock signal. The specified setup and hold
times can be positive or negative values.

Pattern Independent levels for One to specify pattern Trigger when a Boolean combination of up to four
%} each channel duration channels becomes true. Trigger immediately or only after
the combination is true for a specified time duration.
State %] Independent levels for None Trigger on transition of one channel when a Boolean
each channel combination of up to three other channels is true.
Window N Independent levels to One to specify inside or One to specify inside or outside time
# outside time

/

specify window




To Use the A (Main) and B (Delayed) Triggers

You can use the A Event (Main) trigger alone or combine it with the B Event (Delayed) trigger to capture more complex signals.

Set the A trigger type and source in
the A Event (Main) tab of the trigger
control window.

Choose a function in the A—B Sequence tab of 2
the trigger control window.

Set the trigger delay time or the number 3
of B events, as appropriate.

Specify a reset when the B trigger event 4
does not occur.

Set the B trigger characteristics in the B Event §
(Delayed) tab of the trigger control window.

Trigger on B Event

The A trigger arms the oscilloscope.
Posttrigger acquisition starts on nth B event.

B Trigger After Delay Time

The A trigger arms the oscilloscope.
Posttrigger acquisition starts on the first B
edge after the trigger delay time.

Ilode AEdge — Trigger After Time -+ BiEveni - Acquire

A Event Ref Pt

A->B Sequence Horizontal Trigger Reset

A Only Delay Mode _f—\—_- Type
m n n n H Nane ¥

AthenB —— BEvert
Trig After Trig on !
Tirne rith evert Trig Delay Wait indkfinitely for B Event after A

5.0ns trigger

B Trig Level
2.28Y

A Event A->B Seq [ BEvent |

Edge - Source

Pretrigger Posttrigger
record record
Atrigger point |<— Acquired waveform record ———|
[}
Atrigger . |
source | I
I
source N v . :
Waitin; for nth Btrigger point
event (Where n=5)
Atrigger point
| |
Atrigger \ﬁﬂﬂﬂﬂﬂﬂjﬂjﬂﬂﬂﬂﬂﬂﬂﬂ_ﬂﬂ
source | I I

|

|

B trigger MMKJL\\_K_M
source |<_ Trigger ]

delay time B trigger point

More Operating Tips:

m  B-trigger delay time and horizontal delay time are independent functions. When
you establish a trigger condition using either the A trigger alone or the A and B
triggers together, you can also use horizontal delay to delay the acquisition by an
additional amount.

=m When using the B trigger, the A and B trigger can be any of the following types:
Edge, Glitch, Width, or Timeout.



To Perform Mask Testing

Select Mask Setup in the Masks menu. | —=|I}

Mask Type...
Source...
Tolerance Setup...

mMmh App  Utili

Choose a mask type (CSA7000B shown). 2

Pass/Fail Setup...
Pass/Fail Results...

Mask COn
Mask Controls...
Mask Configure 4

Mask Edit Setup...
Mask Edit Controls...

FC2125 Optical (2,125 Gb/s)

None
FC133 Optical (132.i] Mb/s)
F266 Optical (265.6] Mbis)
FC531 Optical (531.2)5 Mbs)
FC1063 Optical (1.06(5 Gb/s)
FC1063 Draf|Rev 11

Choose a mask standard. 3

Select Autoset to automatically set up the 4 —
controls based on the input signal.

Optionally select Autofit to align each § —
acquired signal with the mask to
minimize the number of hits.

Use the Source tab to select the source of
your signal.

Use the Tolerance tab to increase or decrease rce
the mask margin used in mask testing.

ail

Alignment

Autoset  Autofit

Taolerance

Mask Margin Tolerance

Margins

— ANSI X3.230-1999 NCITS1235D/Revii

I




To Set Up Mask Pass/Fail Testing and View Results

Use the Pass/Fail Setup tab to set up Pass/Fail { [ ™ : c .
testing. Pass/Fail Test Hotifications
# of Wims Failure Completion
Stop Acy Beep

Use the Pass/Fail controls to start, stop, or 2 —
continuously run a mask test. Fail Thresh

1]

Test Delay *
0.0 -

Use the Polarity controls to select testing the 3
positive, negative, or both the positive and
negative pulses.

Enter the number of waveforms to acquire and 4 — >R RTT TS When using masks that enable the Wavefprm Database mode, the
use in your mask test. o # of Wims field changes to # of Samples field.

Enter the number of waveforms that must fail to 5§ — BRI
consider the test a failure. o

Enter the time that the instrument delays before @ —> IR EE L]
starting the mask test. 0.0

Use the Pass/Fail Test Notification controls
to select how you want to be notified when o o
a failure occurs and when the Failure Completion
mask test completes. Beep Stop Acq Beep

Use the Pass/Fail Results tab to view the Source T
results of your mask testing. Pass/ Fail Test Summary

d of 20

Total Hits
1]

— Hits per segment




To Take Automated Measurements

Touch the Meas button, and then select up to ——>
eight measurements using the measurement
control window.

Use the tabs to choose measurements in ——— CEREE g n Measurements Setup

Ref Levs

the various categories.

E

Gating Snapshot
I

Histogram

Annotation
Weas 1 1

Measurement Setup...

Snapshot...

High Level
Time 4 Low Level
Comm 4 Amplitude
More 4 Maximum
Histogram 4 Minimum

Or choose a measurement for the selected Statistics & Peakto Peak
waveform directly in the Measure menu. Pos Overshool
Reference Levels... Neg Overshoot
Gating 4 Mean
RMS
Waveform Histograms * Cycle Mean
Annotation »|  Cycle RMS
I—

L

Automated Measurement Selections

Amplitude Time More Histogram Comm
A1 S I IR oo
Amplitude Max Rise Time P\?VSI(I};\IIIB Area (\)IO\ZI){ITII Max ExtRatio Eye Height Eye Top
High Min - Negative Hits in i - Eye Width Eye B
Fall Time V\?I o Cycle Area Box Min ExtRatio% | Eye Widt ye Base
Inin S oy | |
Positive Negative Peak ) : g
Low Pk-Pk Duty Cycle | Duty Cycle Phase Hits Pk-Pk Ext Ratio (dB) | Crossing %
i urst
RMS %ﬁg Period Delay Width Median Mean Jitter PP | Noise PP |Cyc Distortion
Positive -
Overshoot Mean Frequency Std Deviation | u +20 Jitter RMS | Noise RMS | Q-Factor
Negative Cycle . i
ot | oan pxto w =30 Jiter6o | S/N Ratio




To Customize an Automated Measurement

Use Gating to confine the measurement to a
certain portion of the waveform. Use cursors or
any of the four MultiView Zoom areas to define

the gate region.

Measurement statistics characterize the
stability of the measurement.

High Ref Measurement Snapshot on G
] Period : Freq :
Pos Width : 111.01n: Meg Width :
Burst
. o i Rise Time Fall Tim
Adjust the measurement reference levels to - bl N Duly Coc
different relative or different fixed values. - : ebol FHIR

Min
Amplitude
Low Ref Mean Cycle Mean :
1 RMS Cycle RMS :
Area Cyc Are

Select snapshot to see a one-time view of
all valid Normal or Comm measurements.

To Set Up a Histogram

M- . Zoom 10n
Zoom 2 0n

Touch and drag across the segment ofthe { ——— . \\ i cemsen |
waveform that you want the histogram to cover. : ; o AR
To set up a horizontal histogram, for example, : : 2. [\ Eee——
make the box wider than it is tall. : : .

. . . Histogriar | Gffi
Meastirer | emt Gating Gff

Cancel

Select Histogram Horizontal from the 9
drop-down list.

Masks Math App Utlites

View the histogram at the top or edge of 3 —> ]

the graticule.
If you need to make any adjustments to the 4 Waveform Histogram ; . —
histogram, use the histogram setup control Stonre Histogram — - Histogram 24y
window. Select Waveform Histograms in the [cn iR Linea _ _
Measure menu. : | —

Log Left Limit

-1.056ps

Adjust

Take automated measurements on histogram _
data. See previous page for information. ‘ Histo Size Right Limit Lirits

2.0divs -584.0ns




To Take Measurements With Cursors

Cursor Source

Push the front-panel CURSORS button. 4

[ |
Select the waveform you want to measure and 2 =
a cursor type in the cursor control window. | E

Or you can activate cursors on the selected Cursor Type
. . (o] M Me - e
waveform directly in the Cursor menu. e = fBa vieveiom

Cursor Controls...

Cursors On

Cursor Type > H-bars

Cursor Moda 4
e

Waveform

Cursor Position...
Screen

Cursor Setup...

T — Cursori — CLII’SOI’2
Push Setup and place cursors withthe § ———— Source ; | SRl
multipurpose knobs or enter the cursor g chi ¥ R

locations numerically. X Position ® : X Position
| | - |

2080s |- | -20 Bys I

If you choose Waveform cursors to take 4
measurements between waveforms,
select the source for each cursor.

Gurs! Pos
288

iy Gurs2 Pos
20 6ps
1l

bt M T‘A

e 500my ©Q IeE V1 20 .OmV. t: -2€ 8us 10.0us
| 20v A v2: &0 .cmV t2: -20 us 5.0MS/s 200ns/pt

i 83 T agomv
AV/AL 12 2kV/s 1/At: 122 CkHz

Read cursor measurement  §
fesults in the display. Other Cursor Measurement Tips:

®  You can set the cursors to move together in tandem if you choose the Tracking
cursor mode. The cursors move independently if you choose the Independent
cursor mode.

m  |f you use the zoom graticule, you can place a cursor directly on a specific
waveform point to take precision measurements.

®  You can also move cursors by touching or clicking them and then dragging them
to a new position.



To Use Math Waveforms

App Utilities  Helg

Select Math Setup in the Math menu. 1 h Setup... X

Choose one of the predefined math equations. 2

Or touch Editor to define a more advanced math

Display On/Off...
Position/Scale...
Label...

Ch1-Ch2
Ch3 - Ch4
Ch1~Ch2
Ch3 " Ch4

Spectral Setup...

Magnitude Spectrum
Phase Spectrum
Spectral Controls...

Set Math Averages...
Equation Editor...

((Math 1 )| Math 2

waveform. Then build the waveform expression
using sources, operators, constants,
measurements, and functions.

To Use Spectral Analysis

In the Math menu, select Spectral Controls to

define FFT magnitude and phase waveforms.
When an FFT waveform is selected, you can

use the multipurpose knobs to adjust the FFT
waveform just as you would using a spectrum
analyzer.

Time Freg

(T [ & ()

Math 1 W

Freq Span
31.25MHz

Res BW

50.0kHz

Ref Level
20.0dB

SefLp

Math1 = Chi*Ch2

Display

Label

[ Math3 [ Matha

Define/Edit Expression

Editor

Cancel

~— Adjust FFT center

frequency

FINE

~—— Adjust FFT span

You can view time-domain and
frequency-domain waveforms
simultaneously. You can also use
gating to select only a portion of the
time-domain waveform for spectral
analysis.




To Store Information

To Save and Recall Waveforms

To save or recall waveforms, select
Reference Waveforms and then Save Wim...
or Recall Wfm. ... in the File menu.

Or touch the Refs button.

Use the reference setup control window to copy
a live waveform into one of four nonvolatile
reference waveform storage locations. You can
also display these waveforms as reference
waveforms.

Select Save Wfm to File to store the live
waveform as a file on a disk drive. You can
recall a waveform stored on disk into one
of the internal reference waveform
locations for display.

To Save and Recall Instrument
Setups

To save an instrument setup, select
Instrument Setup in the File menu.

Or touch the Setups button.

Use the settings control window to save the
current setup into one of ten internal storage
locations. Use the pop-up keyboard to label the
setups for easy identification.

Or select Save Settings to File to store the
current setup on a disk drive. You can recall any
setup stored on disk and then save it in an
internal setup storage location for

quicker access.

To restore the oscilloscope to a known initial state,
push the front-panel DEFAULT SETUP button.

Or select Recall Default Setup in the File menu.

=[N Edit Vertical HorizfAcq Trig Display Cursors Meas

Reference Waveforms >

Instrument Setup...

Reference Setup...
Rt
Display On/Off... @

1 ] Recall Default Setup Position/Scale...
Page Setup... Label...
Pt Preyiew _
ennt.... Ctri+P Save All Wims
Export Setup... Recall Wfm...
Select for Export Delete All Refs
Evnart
—
2 || Ref2 Ref 3 Ref 4
Position - P Save Wfm to Refi
Display — e
0.0div
Scale
Label 10my |
ref2 lahel n “
3 —mms
Horz Pos
HIW Edit Verical Horiz/Acq Trig
Reference Waveforms 4 SE[UDS
1 —_ Instrument Setup... s

Recall Default Setup
Page Setup...

Recall Refl from File
PR
-

D R»:J:cal\

Delete Wfm File

| Delete

| Close

Save Settings to
File

—»| DEFAULT
SETUP

E3 Edt vertical Horizicq Trig
Reference YWaveforms 4
Instrument Setup...

Recall Default Setup L3

Page Setup...




To Print a Hard Copy

&N Edit Vertical Horiz/Acq Trig

. . »
To print a hard copy to an attached printer or a —=| PRINT Reference Waveforms
network printer, push the front-panel PRINT Instrument Setup...
button. Recall Default Setup
Page Selup...
Or select Print in the File menu. If necessary, Print Preview
you can make changes to the page orientation Print... r__ Cir+P
in the Page Setup dialog box. Evnadt Satin
) . Falette Wi Image
The Page Setup dialog box also includes —— | = ¢y & FulSoesn & MNormal
selectors for the print palette and a feature
called Ink Saver. Ink Saver optimizes the " Black & White C Graticule(s) Only || © Ink-saver Mods
display colors and shades for printing hard (Enhanced)
copies on white paper. ™ Readouts Below Graticule

I© SetFront FPanel Frint Buttan to Expoart

To Copy or Export Your Results

0 vettical HoriziAcq  Trig

Copy Ciri+C
Clear Data
You can use the Windows clipboard to — - IES MG BT ETNCITE
copy information. Simply select the item Copy Selup.. Savetom ot
to copy, copy it, and then paste it into Measurement (data)

another Windows application.
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You can export waveform data into a comma- » -1%20379613,-1400249222, -1407839845, -1415300200,

separated ASCII file for use in a spreadsheet or

—-14226295596, -1429527356, -1436592513, - 1443825313,
—-1479636700,-14572855891, -1463518722, -1529021630,

data analysis program. Select Export Setup in the -1520765593, - 1541896902, - 1488577715, 1494424516,
File menu to set the output content and format -1500133037,-1505702749, -1511133139, ~1516423702,
for images, waveforms, or measurements -1521573950, -152 6583406, -1531451606, -153 6178093,

—-1540762450,-1545204233, -1549503037, -1553 658465,
—-1557670132,-15615357666,-1565260711, -15688385922,
—-1572271966,-15755559525, -1578701302, -15516965995,
—-15584546339,-1587245060, -1559504913, -1592213660,
—-1594475079, -1612554549, -1598555107, -1600373340,

—1EN?N42400 188770801 A 1 ENd0ea03? _1&NE1 Srace




To Run Application Software

You can install and run optional application software on your oscilloscope. These software packages provide advanced capability
supporting many applications. Two examples are shown below; additional packages may be available. Contact your Tektronix
representative for more information.

[ Tek Run Sample

["vert W Horiz I Trig_JJ[ Disp JN Cursor J|_ Meas JN Masks JI_Math ]

M40.0n3 £.0634
A Ch3 o~ 106m ¥

Inputs: Main

characterize timing performance. Analyze
jitter on contiguous clock cycles using
single-shot acquisitions. "

Source 2 Ref Levels

Autaset

Hysteresis &

A0my

Gating Off

Fle Edt ‘et |Hoi4oq Trg Diclay Cursrs Mesmire Masks Vah App Uties Hep Euttons
oo TRE. 1 by 10 AEA00

Use TDSET3 Ethernet Compliance Tests e T e —
Software to test to all three Ethernet standards: [ rosteover |
10baseT, 100BaseT, and 1000BaseT. oo | E"h ﬁ"a o fnie=
oo oo =
m H n Sofarr  WewsdFi h,&dll Iﬁ

AT =T e

N Ulilities Help Buttons

Follow the instructions provided with the ————— BT IR ENVE S
application software to install it. To run Jitter Analysis 3 Essentials
the software, select the application in the
App menu.



To Connect to a Network

Like any other Microsoft Windows-based W
computer, you can connect the oscilloscope = =
to a network to enable printing, file sharing, ! I /
internet access, and other communications ] Network

functions.

To make a network connection, consult with
your network administrator, and then use the
standard Windows utilities to configure the
oscilloscope for compatibility with your
network. See your manual or online help for
more information.
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To Use a Dual Monitor

Connect a keyboard, mouse, and monitor to o [E]
the oscilloscope and configure Windows for coo o
dual-monitor mode. You can operate the IS
oscilloscope while having full use of CE
Windows and other installed applications on Sos
the external monitor. @‘ P
Connect the monitor to the upper XGA port - = @ Q Q9

on the oscilloscope rear panel. Use the
Settings tab in the Windows Display
Properties dialog box to set up a
dual-monitor configuration.




To Access the Help System

Touch the HELP button or select Help on ——
Window in the Help menu to receive
context-sensitive help on the current setup.

Utilities Buttons B Overview
Help Topios|  Back Print Options Close: Minirize
Offset
Contents and Index... Doz D) Posiion & Soale Difset >
To Use

Use the Vertical Offset controls to set the offset value of the selected
waveform to shift the vertical acquisition window to match the waveform
data you want to acquire

Specifications...
Technical Support...
Customer Feedback...

Touch a channel tab at the top of the control window to select the vertical input channel. Touch the
offsst control to map it to ane of the mullipurpase knobs. and then use the knob to st the ofiset
wvalue,

About TekScope... Behavior

Use the offsst contral to eliminate clipping the waveform. The offsst control affects the vertical

Select Contents and Index in the Helpmenuto

access any topic in the help system. Select the
topic, and then touch the Display button in the
dialog box.

acquisition window by subiracting a DI bias from the waveform, This maves the level at the vertical
center of the acquisition windaw of the selected channel, ‘Visualize offset as scraling the acquisition
window towards the top of a large signal for increased offset values and scralling towards the bottom
for decreased offset values

|

The offset control affects the display of the wavefarm by defining the channel reference indicator o
match the offset rather than the ground level. The offss afiects only channel waveforms as compared
to the positian control that afiects all waveforms, including math and reference waveforms

What do you want to do next?

J Continue to learn about the vertical setup contrals

TDS7000B and CSA7000B Ser.

Cortents | index | Find |

Click atapic, and then click Display. Or click ancthertab, such as Index

{2 Introducing the TDS70008 and CSA7000B Series Instruments
[2) Aboutthe TDS70008 and CSAZ000B Series Instruments
JE]

Key Features
Analysis and Connectivity Support
[ specifications
[ Using Online Help
@ Accessories

@ Front Panel

@ Screen Interface
Howto?

@ Deskiop

@ RearPanel

@ Reference Information

Display Frint Cancel

Help Topics:

Erint Options Close Minimize

Vertical Setup Control Window

Access this control window from the Yertical menu.

Y

Overview Display N Postion £5eal Y Offset

Touch an outlined control shown in the help ————
window to receive more specific information
about the control.

Control Window Overview

Use these controls to sst the vertical parameters for live (channel)

channel are independent; use the tabs at the top of the control wi
to change.

Touch a tab in a help window to navigate
between the Overview and specific topics.

Print Options Close Minimize
For mare information on a control, touch one of the highlighted ar
[ Vertical Position & Scale
The Termination, Coupling, and Bandwidth selections may be Overvien Y Display Y Position & Scale Offset s
you are using 3
To Use|
Use thi| Position control to set the vertical pasitic|r of the waveform on
== the scr|en. Use the Scale cantrol window to conifol the vertical scale
Display of the v|avefarm. Touch the cartrals ta map them [o the multipurpose
knobs, [ind then uge the knobs to change the wa [zforms.
Behav[or
Each w|weform has a vertical position control. Th | control increases
Vertien 2. or decr| ases the vertical position of the wavefarm
G 0.2 divisions {0.02 divisions with F |{E control). Increasing the position value [ the waveform
maves the waveform up, and decreising the position moves the waveform do|n
What do you want to do next? Each waveform also has a vertical [:cale control. For a signal with a constani[amplitude,
increasing the scale causes the wlveform 1o be displayed smaller. Decreasi |g the scale
| Continue ta leam about the vertical setup controls. causes the waveform to be display|ed larger
Far channel waveforms, the scale |etting controls the vertical size of the accfisition window as
well ag the display scale. The rang|s and resolution of the scale value depenc|s on the attached
probes and on any other extemal flctors you have specified
[
WTip Use the dedicated knoh on [+e front panel to contral the position and :|=ale of the
selected waveform
What do you want to do next? v
< >

Touch the Minimize button in a help window

to move help out of the way so you can
operate the oscilloscope. Touch the Restore
Help button to see the last help topic again.

Aestore Help |



Front Panel Inputs and Outputs

CSA7000B Series

Probe compensator output to compensate
and deskew probes

Recovered clock outpuyp ——————|

Recovered data output
Optical input to O/E converter

Electrical output from O/E converter

Channel inputs

TDS7000B Series

) [ ————<F—— Diskdrive accessible from

Windows. Option FHD:
removable hard disk in front
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) [ ————<——— Diskdrive accessible from

Windows. Option FHD:
removable hard disk in front

Probe compensator output to compensate ® © @J

and deskew probes

Auxiliary input to provide an external

044— Ground terminal
J

J

-

trigger input

Auxiliary output to provide trigger

output signal

Analog signal output from the CH 3 input

Channel inputs




Rear Panel Inputs and Outputs

Removable hard disk drive to provide individual ——— () ‘ ‘ O

environment for each user or to secure data;
loosen and then pull on thumb screws to release
the disk

CD-RW drive accessible from Windows; press ——= () ] = O
cover to open the drive

Connectors for speaker and microphone @ 7N @

USB connector for mouse, keyboard, or
other peripherals

PS-2 connector for mouse

PS-2 connector for keyboard

RJ-45 connector to connect to network U %
wol | a0l
Upper VIDEO port to connect a monitor for @ @ @i?@

dual-monitor operation

COMT1 serial port

other device

Parallel port (Centronics) to connect printer or > @&KOOOOOOOOOOOOOOOOOOOOOOOOOJ}@ LpT

SCOPE
XGA OUT

Lower XGA port to replicate the oscilloscope display
on an external monitor

GPIB
IEEE STD 488 PORT

GPIB port to connect to controller ~ @ @
QOO

NS /0 N S
CSA7000B only: Auxiliary (external trigger) 4

input, Auxiliary (trigger) output signal, Analog
(CH 3) signal output

External reference input and internal
reference output



Recommended Probes and Accessories

CSA7000B & TDS7000B Series

P7240 4 GHz Active Probe for P7260 6 GHz 5x/25x Active
general-purpose applications Probe

CSA7000B only. O/E-to-TekConnect and
differential-signal and low-noise O/E-to-SMA adapters for O/E converter
applications

P7350SMA Differential probe for TCA-1MEG Buffer Amplifier to connect
differential-signal and low-noise 1 MQ accessories
applications

P7380SMA Differential probe for TCA-SMA, TCA-BNC 50<2, TCA-N, and
differential-signal and low-noise TCA-75 adapters for your probes and
applications cables



